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CI223971 

Civil and Survey Workflows Utilizing the Architecture, 
Engineering & Construction Collection 
Dino Lustri, P.E., P.S. 
D.L. Engineering & Surveying 
 
 

Description 

Seasoned Autodesk users may have routines and processes that have served them well in the 
past. This class will provide a modern perspective of legacy workflows that still are crucial parts 
of day-to-day civil/survey consulting processes, proposals, and workflows. Take advantage of 
the tools provided with the Architecture, Engineering & Construction Collection, and relearn 
previous workflows that may have changed in recent releases of Civil 3D software, AutoCAD 
Map 3D software, ReCap software, and other tools. 

 
Speaker 

Dino Lustri, P.E., P.S. is a consulting water resources engineer and surveyor. He began using 
Autodesk software in 1987.  Dino has extensive experience in information technology. His 
professional experience includes hydrologic and hydraulic modeling as well as contracts in 
construction. He has acted in the capacity of city engineer, and provides expert testimony in legal 
cases. He has provided training for numerous organizations as well as authoring a variety of 
training materials and best practices for civil engineering and surveying workflows. He is a past 
president of the Professional Land Surveyors of Ohio, Cleveland Chapter.  His present duties as 
Special Projects Engineer for the City of Cleveland, Department of Port Control is oversight for 
two airports and a municipal harbor. 

 

Learning Objectives 

 Learn how to incorporate record map electronic data from government agencies into 
your base-mapping efforts, for example, County DGN files 

 Learn how to locate, download, and selectively import FEMA flood map 
information so coordinate systems match and data sets are manageable, SHP files 

 Learn how to utilize available point cloud data, classify it (isolate ground points 
from other points), and generate a Civil 3D surface from the points, LAS files 

 Learn how to use the GEOMAP command in Civil 3D to aid in preliminary efforts 
and provide context to smaller sites 

 BONUS:  Learn how to use AutoCAD MAP 3D, within Civil 3D, to import GIS 
contours with elevation values, SHP files  
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OBJECTIVE 1 - Incorporating record map electronic data from government 
agencies into your base mapping efforts.  (DGN files) 
 

The proper way to start any effort in Civil 3D is by starting a new drawing based on 
your template.  In the absence of a properly customized template, we can start with the 
default Civil 3D template that is provided with the installation of the software. 
 

This lesson will provide the detailed steps to setup, import and organize data provided 
in a non-Autodesk format.  An added twist is the original data is in a different coordinate 
system than our working drawing.  We will perform a coordinate conversion during the import 
process. 
 

Utilizing the MAPIMPORT command 
There are a number of file types that aren’t native to Autodesk products that we might 

want to utilize in our drawings.  Some of those file types include…. 
 

ASCII Point Files (*.TXT, *.CSV, *.ASC, *.NEZ) 
Autodesk SDF (*.SDF) 
CityGML (*.GML, *.XML, *GZ) 
ESRI ArcInfo Export (*.E00) 
Geography Markup Language (*.GML, *.XML, *.GZ) 
Google (*.KML, *.KMZ) 
MapInfo (*.MIF, *.TAB) 
MicroStation (*.DGN) 
MasterMap (*.GML, *.XML, *.GZ) 
Spatial Data Transfer Standard (*.CATD.DDF) 
SQLite Spatial (*.SQLITE) 
Vector Product Format (*.FT) 

 

1) Open a new drawing based on your template or the default 
Civil 3D template. 

a. Click on the QNEW button. 

Or start by opening CI223971-Lustri-AU2018-01.dwg 
 

 

 

 

 

b. On the Settings tab of the toolspace, right 
click the drawing name and then select Edit 
Drawing Settings… 
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c. Assign the Zone Category as USA, Ohio and set the Available coordinate systems: 
as NAD83 Ohio State Planes, North Zone, US Foot (OH-83NF) 

 

 

 

 

 

 

 

 

 

 

Click OK when 
finished. 

 

 

In lieu of the previous steps, start by opening CI223971-Lustri-AU2018-02.dwg 
 

2) Type MAPIMPORT at the command line. 
 

a. Set the Files of 
Type: to 
MicroStation File 
(*.dgn) 
 
 

b. Browse to the data 
files folder and 
select 203p9.dgn. 

 
 

c. Click OK. 
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3) In the resulting Import dialogue box, select Load… under saved profiles and browse to the 
data folder. 

 

 
4) Select Cuyahoga County DGN Import Settings USE WITH MAP IMPORT COMMAND.IPF 
 
 
 
 
 
 
 
Click Load. 
 
 
 
 
 
 
 
 
One of the benefits of loading this preconfigured file is the second column (Drawing Layer) and 
another benefit is the fourth column (Input Coordinate System).  In the drawing layer column, you 
can assign whatever layer you want to use and import the sources DGN drawing levels into your 
layer naming convention.  The Input Coordinate System column represents the original coordinate 
system of the file you are importing (i.e. dgn).  You will have to determine what coordinate system 
the source files are defined.  Note the upper left corner of the dialogue, this represents the 
coordinate system of your drawing and what the imported file will be translated to.  In this case 
Cuyahoga Regional Geodetic Survey (CRGS) is a local proprietary coordinate system developed by 
the County before State Plane systems were commonplace. 
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 After reviewing the dialogue and replacing the missing settings, click OK to import the data. 
 

5) Zoom extents to see the imported data. 
TIP: Try double-clicking the roller button on your mouse for a zoom extents shortcut. 
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6) The data is now geospatially rectified, so if you use the GEOMAP command and turn on 
aerial imagery, the imagery will appear in proper context to the data you imported.  Note that 
it is rare that aerial imagery fits perfectly with surveyed data.  The complication lies in the 
many processes and control points used over large areas. 

 
Type GEOMAP in the command line and select A for Aerial. 

 
 
Note that the GEOMAP command will only work 
if you are logged on to Autodesk Cloud Services. 
 
 
 
Q.E.D. 
 
The final drawing in this exercise can be viewed by opening CI223971-Lustri-AU2018-03.dwg 
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TIPS & TRICKS 
Whenever you import files or insert blocks you inevitably are adding data to your 

drawing that was performed in a poor manner.  Either by lack of standards or other bad CAD 
etiquette, data in your drawing will be less controllable if left in this state. 

I have used the following tools for years in attempts to ‘clean up’ imports and other people’s 
drawings so I can spend less time manipulating them and more time using them. 
 
  
Start by opening CI223971-Lustri-AU2018-03.dwg 
 

Start with the last exercise file and turn off GEOMAP.  

1) The first command we will use to clean up the 
data is SETNESTEDOBJECTSBYBLOCK 

a. This command changes all the layers 
inside of a block to layer 0.  In this way 
the block will appear the color and 
properties of the layer that it is on.  
Some would call this good CAD 
practice. 

b. Type SetNestedObjectsByBlock at 
the command line. 

c. You will be prompted to Select Block 
References.  Simply window the entire 
drawing. 

d. Any blocks that were in the windowed 
area now have their layers set to 0. 

 

 

 

 

 

2) Another good CAD practice is the properties 
of your objects being set to BYLAYER, BYLAYER, BYLAYER. 

a. The reason this is said three times is due 
to historic AutoCAD use when Color, 
Linetype, and Lineweight were always 
assigned the property BYLAYER.  
  
This was to allow the appearance of your 
drawing to be easier manipulated by 
changing layer properties rather than 
object properties. 
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b. The next command we will use to clean up the drawing is SETBYLAYER. 
This command changes property overrides of selected objects to ByLayer. 

 
c. Type SetByLayer at the command line.   

 
Then click S for settings. 
 
Check that all the checkboxes are checked or 
manipulate as you desire. 

 

d. Window the entire drawing and press enter. 

 

e. In the command line you will 
see a verification request.  
Click Yes to change 
ByBlock to ByLayer. 

 
f. You will then be prompted 

to verify if you want blocks 
included, click Yes. 

 
You might notice changes to 
your drawings upon 
pressing enter. 

 

3) The next command we will use 
requires the download of a script 
from a user.  Credit should be 
given to Steve Doman for creating 
this LSP routine.  The name is 
STRIPMTEXT. 

This LSP routine will remove the custom 
properties that may be defined in an 
MTEXT object.   

a. Type APPLOAD at the 
command line. 

b. Browse to the location you 
have it stored, select it and 
pick Load. 
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You may be prompted with a Security 
dialogue box stating that it is an 
Unsigned Executable File. 

 

You should be very careful about 
using any executables downloaded 
from the Internet.  USE AT YOUR 
OWN RISK! 

 
c. Click Load Once. 
d. Click Close on the Load/Unload Applications dialogue box. 

 
e. Type STRIPMTEXT at the command line. 

 
f. You will be prompted to select objects, 

window the entire drawing, then press Enter. 
 
 
 

g. The StripMtext dialogue will display.  
Choose the properties you wish to reset by 
checking the associated boxes. 

 
h. Click OK. 

 

The results of the command are evident as all the colors 
revert to BYLAYER and therefore are the color of the 
layers assigned.  Left is before the command, Right is 
after. 
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See the Layer listing. 

 

 

 

 

 

 

Scroll down the layer 
listing to see layers 
that were not 
converted in the 
previous exercise. 

 

4) Often there are blocks within blocks that have the original layer name before they were made 
into blocks.  The following command will help us merge these old layers into the new ones, 
bringing their data with them. 

a. On the Home tab of the ribbon, Layers panel, select the down arrow to the bottom 
right to expand the panel.  Click Merge. 

 

b. You will be prompted to select object on 
layer to merge or [Name].  Choose Name 
and the Merge Layers dialogue will 
appear.   

 

c. Scroll down to pick the redundant layer.  This is 
the FROM layer, you will pick the TO layer next. 
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d. You will still be in selection mode, 
meaning that you can still select 
items.  To end selection mode, 
click Enter one time. 

 
e. You will now be prompted to select 

object on target layer.  This is the TO 
layer. Select Name again to pick 
from the list. 

 
 

f. Choose the proper target layer and click OK. 
 
 
 
 
 
 
 
 
 
 
 

g. You will be prompted with a verification 
dialogue.  Click Yes. 

 
 
 
 
 
 
 

h. Note that the layer named Level 20 no longer exists.  It has been merged. 

 
 

i. Repeat the steps for the other two layers.  Note in this data file Level 31 does not 
have a target layer, you will have to create the layer first for this command to work. 

 
 
 
The final version of this exercise can be found by opening CI223971-Lustri-AU2018-04.dwg 
 
 
Q.E.D. 
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OBJECTIVE 2 - Locating, downloading, and selectively importing Federal 
Emergency Management Agency (FEMA) flood map information to project 
coordinate systems.  (SHP files) 

 
Many consulting engineers and surveyors need to show current flood plain information on 

their base mapping.  The first step is knowing where to go to find that information.  Then we need to 
convert it into our CAD environment, in the project’s coordinate system so that we can add project 
related information to it. 

 
FEMA Data Resources 

The following links provide access to various website locations within the FEMA website… 
 

1) FEMA Flood Map Service Center – This site will provide the user with current Federal 
Insurance Rate Maps (FIRM) 

a. https://msc.fema.gov/portal/home 
2) FEMA Flood Map Service Center – Search All Products 

a. https://msc.fema.gov/portal/advanceSearch 
3) National Flood Hazard Layer (NFHL) – Data Home Page 

a. https://catalog.data.gov/dataset/national-flood-hazard-layer-nfhl 
b. Under Downloads & Resources, you will see a couple options to select… 

i. If you select 
Download Seamless 
Nationwide NFHL 
GIS data… 

 

ii. You will see a folder listing 
files to download, some of 
which are 10-30 GB.  Unless 
you have a computer 
capable of dealing with these 
data sets and/or your project 
requires you to span large 
areas, do not download from 
this location. 

 
 
 

 

iii. If you select Get Flood 
Maps and Data from 
FEMA… 
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iv. You will land on the FEMA Flood Map Service Center: Welcome page. 

 

 

 

 

 

 

 

 

 

v. After typing in your address, you will be provided the search results of 
available effective flood maps, revisions, amendments and revalidations.  
You will also be able to generate a ‘FIRMette’ from this page. 
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4) National Flood Hazard Layer (NFHL) – GIS Viewer 
a. This site is a modern GIS viewer that allows for both the download of FIRMs as 

well as the GIS data that we are interested in. 
b. If you select NFHL Interactive Map (FEMA GeoPlatform) 

 

 

You will land on the official NFHL page, on which the link to the ArcGIS web app viewer is found. 

 

 

 

 

 

 

 

 

 

That link is: 

https://hazards-fema.maps.arcgis.com/apps/webappviewer/index.html?id=8b0adb51996444d4879338b5529aa9cd 

 

Once you zoom into or type in your project 
location, click in the map, and download links will 
appear.  Click on the one that refers to county 
GIS data. 

 

Your download will begin.  Once downloaded, 
extract the file contents to your project folder and 
review the contents. 

 

 

 

Note:  In the XML file which contains the metadata, you will find the coordinate system used as well 
as the vertical datum used in these files.  The PRJ files are just as important as the SHP or DBF 
files.  Make sure you keep all these together in the same folder. 
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Using MAPIMPORT to import FEMA Data  

Start by opening CI223971-Lustri-AU2018-05.dwg 

1) Using a drawing that has information in a geospatially correct location will help in determining 
the area in which to bring in the FEMA data that was downloaded. 

 

2) The list of SHP files that were part of the download are defined in the MetaData file… 
a. S_Base_Index:  Location and attributes for a tiling index for raster data used for the 

FIRM base map. 
b. S_BFE:  Location and attributes for base flood elevations lines shown on the FIRM. 
c. S_FIRM_Pan:  Location and attributes for FIRM hardcopy map panels. 
d. S_Fld_Haz_Ar:  Location and attributes flood insurance risk zones shown on the 

FIRM. 
e. S_Fld_Haz_Ln:  Location and attributes for boundaries of flood insurance risk zones 

shown on the FIRM. 
f. S_Gen_Struct:  Location and attributes for flood control structures shown on the 

FIRM. 
g. S_LOMR:  A spatial data set consisting of polygons that depict effective LOMRs that 

have been incorporated into the NFHL since the last publication of the FIRM panel for 
the area. 

h. S_PLSS_Ar:  Location and attributes of sections, townships and ranges shown on the 
FIRM. 

i. S_Pol_Ar:  Location and attributes for political jurisdictions shown on the FIRM. 
j. S_Profil_BasLn:  A spatial data set consisting of lines showing the flow path used for 

floodplain modeling and mapping. 
k. S_Stn_Start:  A spatial data set consisting of points indicating the location of the 

reference point that was used as the origin for distance measurements along streams 
and rivers. 

l. S_XS:  Location and attributes for cross-section lines in the area covered by the 
FIRM. 

 

3) Type MAPIMPORT at the command prompt. 
a. Set the Files of type to 

ESRI Shapefile (*.shp) 

 

b. Select the 
S_FLD_HAZ_AR.shp 
file. 

 

c. Click OK. 
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4) In the Import dialogue box, 
note the Input Coordinate 
System is present and that it 
is different than the Current 
drawing coordinate system.  
LL83 versus OH83-NF.  
Under Spatial filter, select the 
Define Window button.  

 

 

 

 

 

 

5) Window an area larger than the 
data set in the drawing. 

 

 

 

 

 

 

 

 

 

 

 

 

6) Make sure to check the box for Import 
polygons as closed polylines.  Then 
click OK in the import dialogue box. 
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7) You will see the Import Progress dialogue and shortly after the 
linework will appear in the proper location in your drawing. 

 

 

8) Although the windowed area is smaller, the defined window acts as a crossing window, not 
as an encapsulating window, so anything it touches or crosses will be included in the import. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Q.E.D. 

The final drawing of this exercise can be viewed by opening CI223971-Lustri-AU2018-06.dwg 
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OBJECTIVE 3 – Utilize available point cloud data, classify it (isolate ground 
points from other points) and generate a Civil 3D surface.  (LAS files) 

 
Many jurisdictions are beginning to make available aerial LiDAR data that has been 

organized (classified).  LiDAR is an acronym for LIght Detection And Ranging.  There are numerous 
files types for point cloud data, in this exercise we will be using LAS files. 

 
Ohio Geographically Referenced Information Program (OGRIP) 

The following links provide access to state of OHIO LiDAR data. 
 
1) http://gis5.oit.ohio.gov/geodatadownload/ 
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2) Type 44140 in the Zoom to… box then click the Zoom button. 

 

 

 

 

3) Zoom in closer to 
the tile numbered 
N2125660. 

 

 

 

 

 

 

 

 

 

4) When you click on that tile, the lower part of the dialogue populates with the data that is 
available for that tile.  For example the OSIP I tab provides TIFF, SID, LIDAR, GRID and 
ASCII information.  While the OSIP II tab only provides TIFF and SID aerial imagery. 

 

 

 

 

 

5) By clicking on the blue links, the data files will begin downloading. 
6) Extract the contents of the file in your project folder.  In this case we receive and LAS file 

and an XML file which is the metadata for the LAS file.  This metadata will tell you the 
coordinate system, date the data was obtained and various other information about the 
processing and source of the data. 
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Using RECAP to process point cloud data and prepare it for use in Civil 3D 
 
In previous versions of Civil 3D, there was a point cloud object for the purpose of classifying 

point cloud data and using it to generate a Civil 3D surface.  In present releases Autodesk products, 
namely the AEC Collection, the point cloud processing was removed from Civil 3D and placed within 
RECAP which is the subject matter application. 

 

1) Launch RECAP.   
 
 

 

 

 

 

 

 

 

 

 

 

2) Select new project. 
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3) Select import point cloud. 

 

 

 

 

 

 

 

4) Provide a project name and path to save the 
result and click proceed. 

 

 

 

 

5) Choose select files to import. 

 

 

 

 

 

 

 

6) Choose the file and 
select open. 
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7) Select the advanced tab. 

 

 

 

 

 

8) Enter the coordinate system you determined from the XML file metadata in the current 
field and enter the coordinate system of your drawing in the target field. 

a. Begin typing the coordinate system ID if you know it and the right search results 
will display all that being with what you type.  If you know the EPSG then you can 
enter that as well. 

 

 

 

 

 

 

 

 

b. Do the same effort for the target field. 
c. Verify that your dialogue looks like the below before selecting import files. 
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9) The point cloud is processed and you will see the progress wheel icon 
in the upper left. 

 

 

 

10) When it is complete, the wheel icon will display as a solid color. 

 

 

 

11) Highlight the wheel icon and click index scans. 

 

 

12) The bottom of the screen will indicate the 
progress. 

 

13) Click launch project.  

 

14) A visual representation of the LiDAR file will display on your screen. 
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15) Hover over the house icon and select the ‘floppy disk’ icon for 
saving your processed work. 

 

 

 

16) Launch Civil 3D.   

Start by opening CI223971-Lustri-AU2018-07.dwg.  Note this drawing had the coordinate system 
assigned in the previous steps.  If you start from a new drawing, make sure to assign the correct 
coordinate system. 

 

 

 

 

On the Insert tab, Point Cloud panel, select Attach. 

17) Select the RCP file that you created in the steps above and pick open. 

 

 

18) In the Attach Point Cloud 
dialogue box.  DO NOT 
CHECK Use geographic 
location. Uncheck the 
Insertion Point, specify on-
screen. 

Click OK. 
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19) The point cloud should have imported to the proper location. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

20) Click on the point cloud’s edge to launch the contextual ribbon. 

 

 

a. On the contextual 
ribbon, visualization tab, 
click the lower half of the 
Scan Colors button to 
display the other 
visualization options.  
Select Classification. 
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b. This will verify that your LAS file had classes defined.  In the below image you see 
gray representing buildings, green representing vegetation, and brown 
representing ground. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

21) At the command line type MAPCREATEPCSURFACE.  Be sure to type the correct 
command, there is a similar command called Mapcreatesurface that is incorrect for this 
process. 

22) You will be prompted to select the object, pick the edge of the point cloud object.  Then 
press enter. 

 
23) In the Create Surface from Point Cloud dialogue box, choose the output file name and 

location, (Note the TIF suffix).  Select Filter. 
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24) Choose Ground and click OK. 

 

 

 

 

 

 

 

25) Click OK on the subsequent 
dialogue too. 

 

 

 

26) After the point cloud processes, you will not see a 
change in the point cloud object. 

 

 

27) To create a surface based on the TIF you just 
generated, go to the Home tab of the ribbon, 
Create Ground Data tab, and click the down arrow 
to the right of Surface.   

 

 

28) Select Create Surface from DEM. 
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29) Browse to the TIF you 
generated, make sure the 
Files of type is set to 
GEOTIFF (*.tif) and select 
the file, then click Open. 

 

 

 

 

 

 

 

30) Once it is finished processing you will notice a Civil 3D surface appear under the point 
cloud. 
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The drawing at this stage can be observed by opening CI223971-Lustri-AU2018-08.dwg.   

 

31) To manipulate the point cloud, i.e. turn it off, but not 
detach it, click on the point cloud object to launch the 
contextual ribbon.  On the Options tab, click Point 
Cloud Manager.  In the Point Cloud Manager, 
clicking the radio button for the scan will turn off the 
visibility like turning a layer off. 

 

 

 

 

 

 

The drawing at this stage of this exercise can be found in 
CI223971-Lustri-AU2018-09.dwg.   

 

32) Alternatively, you could go to the XREF dialogue box and detach the point cloud 
permanently. 

 

 

 

 

 

 

 

 

33) Even with the RCP detached, the surface can still generate 
profiles. 
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The drawing at this stage of this exercise can be found in CI223971-Lustri-AU2018-10.dwg. 

34) Using the LEVELOFDETAILOFF command allows you to keep all the contours on if you 
wish.  Using the LEVELOFDETAIL command will all the system to display contours 
dependent on your zoom level. 

 

Q.E.D. 
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OBJECTIVE 4 – Utilize MAP to import SHP file contours with elevation values.    
(SHP files) 

 
ESRI SHP files come in many variations.  Autodesk added a great tool to automate the 

process of importing SHP contours while adding the elevation data and generating a surface thorugh 
a wizard interface.  Sometimes the SHP file does not work with that command.  The below steps will 
show the ‘other’ method to assign elevation data to the CAD objects so Civil 3D can utilize it to make 
a surface. 

 
Utilizing the CREATESURFACEFROMGISDATA command 

This process demonstrates the wizard added to Civil 3D for the purpose of importing ESRI 
SHP contour data into Civil 3D while generating a surface. 
 
Begin by opening CI223971-Lustri-AU2018-11.dwg.  If you are starting from a new drawing, it is 
imperative to assign a coordinate system before continuing. 

 
1) On the Home tab of the ribbon, Create Ground Data panel, click the down arrow next to 

Surfaces and pick Create Surface from GIS Data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note that you can type CREATESURFACEFROMGISDATA at the command line to 
launch the same wizard. 
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2) In the Object Options dialogue 

box, assign a name, assign a 
style and click Next >. 

 
 
 
 
 
 
 
 
 
 
 
 

3) On the Connect to Data dialogue 
box, click the SHP radio button 
then click the ellipsis to browse 
to the SHP file. 

 
 
 

Click Login. 
 
 
 
 
 
 
 

4) On the Schema and Coordinates 
dialogue, select the check box 
next to the Feature Class, then 
click Next >. 
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5) On the Geospatial Query 
dialogue box, select the Window 
radio button.  Make sure the 
Query Type is set to Crossing 
and click the query button. 
 
 
 
Window the target area you 
want imported.   
 
 
Click Next > to continue. 

 

6) On the Data Mapping dialogue, 
assign the elevation property 
next to the Elevation GIS Field. 
 
 
 
 
 
 
 
 
 
Click Finish to complete the 
wizard. 
 
 
 

7) A Civil 3D Surface will be generated. 

 

 

 

 

 

 

 

The drawing at this stage of this exercise can be found in 
CI223971-Lustri-AU2018-12.dwg. 
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Utilizing MAP to process a SHP file that does not work with the 
CREATESURFACEFROMGISDATA command 

This process demonstrates how to use MAP in order to work around SHP files that do not 
cooperate with the wizard. 
 
Begin by opening CI223971-Lustri-AU2018-13.dwg.  If you are starting from a new drawing, it is 
imperative to assign a coordinate system before continuing. 

 
1) To show that the wizard doesn’t work on the second data 

set, we repeat the above steps to attempt an import into 
Civil 3D.  Use the TOPO_08 data set this time. 

 
 
 
 

2) Change the workspace to 
Planning and Analysis. 
 
If the Map Task Pane is not 
showing, type MAPWSPACE at 
the command line and choose 
On. 

 

3) On the Insert tab of the ribbon, Import panel, select Map Import. 

 

 

 

 

4) Browse to the topo_08.shp file 
and click OK. 
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5) On the Import dialogue box, perform the following steps: 

a. Click on the Data field. 
b. Select the Create object data radio button. 
c. Click Select Fields. 
d. Verify the check boxes are selected for the object data mapping. 
e. Click OK. 
f. Click OK. 
g. Click OK. 

 
6) The import will begin processing. 

 

 

7) The imported data will appear. 
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8) By clicking on any of the lines and 
reviewing the properties, you will 
note that the elevation data is in the 
data table but it is not part of the 
AutoCAD object geometry and 
therefore will not be able to 
generate a Civil 3D Surface. 

 

 

 

 

9) Save the drawing and close it. 
 
Note that it is important to close the drawing, or the following query steps will not work. 

The drawing at this stage of this exercise can be found in CI223971-Lustri-AU2018-14.dwg. 

 

 

10) Start a new drawing and assign a coordinate system or open the following: 

Start by opening CI223971-Lustri-AU2018-15.dwg. 

11) Click on the Map Explorer tab of the Task Pane. 

 

 

 

 

 

 

 

12) Right click Drawings and choose Attach. 
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13) On the Select Drawings to attach dialogue, perform the following steps: 
a. Click the Alias 

button. 
b. Assign a drive 

alias letter. 
c. Browse to the 

folder with the 
previously 
saved drawing 
completed in 
step 16. 

d. Click Add. 
e. Click Close. 

 

 

 

14) Assign the drive alias you just created in the Look 
in: location. 

 

15) Select the file saved from the previous steps, i.e. 
step 16. 

 

 

16) Click Add. 

 

17) Click OK. 

 

 

18) On the Task Pane, Map Explorer tab, right click 
Current Query and choose Define. 
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19) In the Define Query of Attached Drawing(s) dialogue, 

query type, choose Location. 
 

 

 

20) Select All then 
click OK. 

 

 

 

 

 

 

21) In the Define Query of Attached Drawing(s) dialogue, 
Query Type, click the Alter Properties button. 

 

 

 

22) In the Set Property Alterations dialogue box. Click 
Elevation and then click the Expression button. 

 

 

 

 

 

23) In the Property Alteration Expression dialogue box, 
expand Object Data, select Elevation and then click 
OK. 
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24) Click Add.  Click OK. 

 

 

25) In the Define Query of Attached Drawing(s) 
dialogue, click the radio button for Draw under 
Query Mode and the click Execute Query. 

 

 

 

 

 

 

 

 

 

 

 

26) Perform a Zoom Extents to show the 
imported data.  Click on a line in the 
drawing and note the properties dialogue 
box compared to the beginning of this 
exercise.  The Elevation field under 
Geometry is now populated with the actual 
elevation.  You can now perform the 
standard Civil 3D Surface Creation steps 
by adding this CAD data to the surface by 
Contours. 

 

 

The drawing at this stage of this exercise can be 
found in CI223971-Lustri-AU2018-16.dwg. 

 

Q.E.D. 
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